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WinDirs Overview
Welcome to WinDirs!    The WinDirs program is a Windows based file management utility which allows 
you to copy, delete, rename, move, view and execute the files on your system.    It also offers a labeling 
function for attaching labels to your files, a graphics viewer for viewing bitmaps and GIF files, and an icon 
viewer for viewing, editing and creating icons.    Using WinDirs's WinGroup Manager you can also add, 
delete and move items and groups in your Windows workspace.    The WinDirs program also gives you 
the option of keeping it (minimized) on top of any Windows application that you are running so that you 
can have immediate access to its functions.

Sub-Topics:
Registration
Viewing and Executing Files from WinDirs
File Labeling



Registration
WinDirs is a shareware program produced by KnowWare in Waldport, Oregon.    It can be registered for 
the price of $20.00 including shipping and handling.    Click on "Registration", in the WinDirs Help menu, 
to fill out the registration form.    Fill in the blanks on the Registration form by tabbing from box to box and 
then click on Print at the top of the form to print it out.    KnowWare's address will appear on the printed-
out form.    Send the form and your check or money order (US currency only) and you will receive an 
updated and registered version of WinDirs.

As you may know, the Shareware concept is based completely on the honor system.    Only in cyberspace
do people still trust each other enough to distribute their merchandise freely and rely on their neighbors to
pay for what they use.    We at KnowWare are firm believers in the shareware concept.    We ask only that 
if you use our program you pay for it.    Feel free to try it out for 30 days.    If you like it and are using it, we 
ask that you register it at that time.

You can reach KnowWare though e-mail.    We welcome any comments or questions you may have.    

Program written by Gary Pease:      techneek@peak.org
Documentation by Cindy Dyrness:    Cdyrness@aol.com or 75573,1717 (C-Serve)

Sub-Topics:
Legal Stuff



Legal Stuff
This program is provided "as is" without representation or warranty of any kind, either expressed or 
implied, including without limitation, any representations or endorsements regarding the use of, the results
of, or performance of the program and information, its appropriateness, accuracy, or reliability.    The entire
risk as to the use of this program and information is assumed by the user.    In no event will KnowWare or 
Gary Pease or Cindy Dyrness be liable for any damages, direct, indirect, incidental or consequential, 
resulting from any defect in the program or information.



Viewing and Executing Files from WinDirs
WinDirs has the ability to recognize file extensions and know what to do with them, so all you have to do 
to view or execute most files is double-click on them.    Double-clicking on an EXE file will bring up a box 
that asks you whether you want to execute the file.    If you choose YES, the file will execute normally, and
after it is finished you will return to WinDirs.

Double-clicking on a text file with the TXT, WRI, or DOC extension will call up a text editor and load the 
text file into it so that you can read or edit it.    If you have a text file with a different extension, you can 
also go to the WinDirs Editors menu and choose a text editor from there.

Double-clicking on a Bitmap (BMP) or GIF file will bring up a graphics viewer and load your BMP or GIF 
file so that you can see what it looks like.    If you double-click on a graphics file with a different extension 
(JPG, RLE, PCX etc.) WinDirs will bring up a file list box labeled "Choose a Viewer" so that you can 
choose any graphics viewer that you have on your system.    For complete instructions on viewing 
graphics files, go to Graphic Viewer Overview.

Double-clicking on a ZIP, ARJ, LZH, or compressed (e.g. dosit.ex_) file will bring up a file uncompression 
box labeled "Archiver jr.".    Archiver jr. lets you choose a directory in which to uncompress the file and 
then uncompresses the file using the PKZIP, ARJ or LHA programs.    For complete instructions, go to 
Archiver jr.



File Labeling
The file labeling function of the WinDirs program can be activated or deactivated with the "Activate File 
Labeling" button below the file list box.    You will want to leave the File Labeling function deactivated 
except when you want to label files or view file labels, because when the file labeling function is active 
most other WinDirs functions are deactivated.    You can, however, still double-click on files to view them 
when the file labeling function is active.

After activating file labeling, highlight the file that you want to label in the file list box.    To type the label, 
click in the text box above the file list box.    Type any label you want, as long as it is not longer than the 
text box, and then push Enter.    When you push Enter, the label shows up in the file list box next to the file
you wanted to label and it is also saved into a file called "_dosit.cat."    Note that this catalog file will be 
created in each drive or directory that you add labels to.    These labels will remain attached to your files 
and you can always see them when you view your files in WinDirs (if file labeling is activated).    The 
labels will not appear if you view the files in DOS or Windows however.    (You can also view the _dosit.cat
file by using the DOS text editor.)    The labels will always be there unless the _dosit.cat file is deleted.    If 
you copy the files to another location, you must copy the _dosit.cat file with them if you want to retain the 
file labels.    You can edit or delete the file labels at any time by clicking on the file and editing the label in 
the text box.



WinDirs Manager Option Buttons and Menus
Click on the buttons and menus to learn about the WinDirs functions.



Make DIR Button
This button allows you to make a subdirectory from wherever you are.    Simply click on whatever directory
you want to make a subdirectory of (in the directory list box on the left-hand side of the window) and then 
click on Make DIR.    A box will come up with the path already displayed.    Click at the end of the path in 
the text box and type in the name of your subdirectory.    Then click on OK or push Enter.    You will see 
the new subdirectory appear in the directory list box.



RD (Remove Directory) Button
The RD button will delete whichever directory you have highlighted, as long as it has no files in it.



Del Dirs Button
This button allows you to delete any directory along with everything that is inside it (files and 
subdirectories).    Highlight the directory that you want to delete.    When you click on the Del Dirs button, a
box will come up asking you if you are sure you want to delete the directory and its subdirectories.    If you
click on YES, you will see the program deleting the directory and all of its subdirectories and all of the 
contents of the directories.



Delete File Button
This button allows you to delete any file or group of files.    Highlight the file that you want to delete in the 
file list box and then click on the Delete File button.    A box will come up asking you if you are sure you 
want to delete this file.    Click on Yes or push Enter and the file will be deleted.    You will see that it 
immediately disappears from the file list box.    Note that if you do not choose a file to delete, the program 
will assume that you want to delete all files (*.*) in the selected directory.    You can also delete a group of 
files by holding down the mouse button and selecting a group of files, OR by holding down the Control 
key and clicking on the files that you want to delete.



Copy/Search Button
When you click on this button, the program brings up the "Echo On" copy and search window which 
allows you to copy any file or group of files to another location, search for files on your system, and also 
change file attributes and format floppy disks.    For complete instructions on Echo On, see Echo On 
Window.



Rename File Button
This button allows you to change the name of any file.    Highlight the file that you want to change the 
name of in the file list box and then click on the Rename File button.    A box will come up with the name of
the file highlighted.    Simply type in the new file name (with extension) and click on OK.    You will see the 
name of the file change immediately in the file list box.



File Extension Box
The file extension box allows you to choose which files you want to view in your file list box.    You can use
it to view executable files by choosing the *.exe extension or select the correct file extension in order to 
see only your graphics files (*.bmp, *.gif, *.tif, etc.) or icons (*.ico).



File List Box
The file list box lists all files that are in the directory or drive that you have chosen in the directory list box. 
You can execute or view many files by double-clicking on them in the file list box.    Most text files can be 
viewed in this way, executable (.EXE) files can be executed, graphics files can be viewed, and 
compressed files can be uncompressed.



Activate File Labeling
This button activates the File Labeling function of the WinDirs Manager, allowing you to append 
descriptions to your files describing what they are or what they do.    For complete instructions on file 
labeling, go to File Labeling.



Win Group Manager
Clicking on Win Group Manager brings up the Win Group Manager window which allows you to add, 
delete or rename items and groups in your Windows workspace and also enables you to execute any of 
you Windows executable files.    The Win Group Manager lists all of your Windows groups and items and 
also has a file list box that gives you access to all files on your computer.    This allows you to rearrange 
your Windows environment in the way that best suits you and to get rid of any groups and items that you 
no longer use.    Go to Win Group Manager Functions for complete instructions on the Windows Group 
Manager.



Win Group Manager Functions

Click on the different areas of the WinGroup Manager window to learn about their functions.    See below 
for further information about the menu items.

Sub-Topics:
Groups
Items
Item Options



Exit
This closes the WinGroup Manager window and returns you to WinDirs.    Exit does not reset the Group, 
Item or Directory list boxes, so that if you return to the WinGroup Manager everything will still be where 
you left it.



Clear
This clears and resets all of the Group, Item, Directory and File list boxes.



Help Menu
This accesses the WinDirs Help file.



Groups Menu
This menu gives you three options.    You can create a Windows group, delete a group or view a group.    
For complete instructions go to Groups.



Groups
The Groups Menu allows you to create, delete or view a Windows program group.    

To create a group, type in the name that you want it to have in the "Group Name" text box.    Then choose 
Create Group from the Groups menu.    You will see your new    group appear in the list of groups.    

To delete a group, choose it in the "Group Name" box and then choose Delete Group from the Groups 
menu.

Choosing "Show Program Group" from the Groups menu will show you the actual group window with its 
icons.    Minimize the Windows Program Manager window to return to the Windows Group Manager.



Items Menu
The Items menu gives you the options of adding an item, deleting an item, deleting an item and its DOS 
file, renaming an item or moving an item.    For complete information on the Items menu go to Items.



Items
The Items menu allows you to add, delete, rename or move any item within a Windows program group.    

To add an item to an existing program group, choose the group that you want to add it to in the "Group 
Name" box and then go to the directory and file list boxes on the right-hand side of the window.    Choose 
the item you want to add (usually an EXE file; but also HLP, WRI, or TXT files can be Windows items) 
from the file list box and then choose "Add Item" from the Items menu.    It will then appear in the list of 
items for that group.    The item will be given a name automatically, but if you want to give it a name you 
can simply type it into the Item Name box.

To delete an item, choose it in the "Item Name" box and then choose "Delete Item" from the Items menu.   
This deletes the item's icon from the Group window, but it does not delete the actual file from your 
computer.    If you want to completely delete a file from your computer, choose "Delete Item and File" from
the Items menu.    This deletes both the Windows icon and the file itself.

To rename an item, choose the item in the "Item Name" box and then delete it and type in the name that 
you would like it to have.    Then choose "Rename Item" from the Items menu and you will see the item's 
new name in the Item list.

To move an item from one program group to another, choose the item that you want to move in the Item 
Name box and then choose "Move Item" from the Items menu.    You will see a Target Group list box 
appear at the right of the window, as shown in the view below.    Choose the group that you want to move 
the item to and then click on the "Move Item >" button.    You will see the item being moved from one 
group to the other in Windows.



Item Options Menu
The Item Options menu allows you to add a group of files to a program group all at once.    You have the 
option of adding *.exe files, *.hlp files, *.txt files, *.wri files, or all of them at once.    For more information 
go to Item Options.



Item Options
The Item Options menu gives you to option of adding a group of program files to a Windows program 
group all at once.    This may be useful if you want to add a program along with its help file and text files.    
You have five options for items to add.    "Add Selected Directory *.exe" will add all EXE files from the 
selected directory to the program group that you have selected.    "Add Selected Directory *.hlp" will add 
all of the help files from the selected directory.    "Add Selected Directory *.txt" will add all Notepad text 
files from the selected directory and "Add Selected Directory *.wri" will add all Windows Write text files.    
"Add All of the Above" will add all of those types of files to your selected program group.    

To use these options, choose a group or create a group in the Group Name box and then choose the 
directory that you want to add the items from in the file list box.    From the Item Options menu, choose 
which sort of files you want to add to this program group and you will then see those items and the 
appropriate icons being added.



Get File Version Info
To use this function, first choose an item in the Item box or a file in the file list box and then click on Get 
File Version Info.    If the item has version information, you will see a window pop up giving you the version
of the file and other information.    If the file has no version associated with it, a message box will tell you 
so.



File and Directory List Box
This list box shows all of the files on your system.    Use this list box to choose the file that you want to 
add as a new item to one of your program groups.



Group Name Box
This list box lists all of the Windows Program Groups that exist on your system.



Item Name Box
This list box lists all of the items that exist within whichever Group you have selected.    (In Windows they 
appear as icons.)



Path Box
This displays the path of the item in the Item Name box or the path of whichever file has been chosen in 
the file and directory list box.



Execute Item Button
Clicking on this button will execute the file which appears in the Path box - if it is an executable file.    You 
can either choose a Windows item from the Item Name box or a file from the system file list box at the 
right side of the window.



Icon Box
The icon of the item that is chosen in the Item Name box appears here.



Shortcut Keys
If you'd like to save yourself a couple of mouse clicks, you can use these shortcut keys instead.    They 
perform all of the functions listed in the menus.



DOS Window Button
This button opens the regular DOS prompt window, which can be closed again by typing Exit at the DOS 
prompt.



Chk Dsk Button
Chk Dsk runs the DOS Check Disk program on either your hard disk or a disk in a disk drive, whichever 
one you have chosen.    It gives you the total disk space, the number of files and how much space they 
take up, and the available disk space.    Chk Dsk also checks for any errors in the integrity of files on the 
disk and it gives you the size of your conventional memory and how much you have available.



Help
The Help menu gives access to this help file and also access to DOS help files.    The "About" box and the
Registration form for the WinDirs program can also be found in the Help menu.



Editors
The Editors menu gives you access to the Notepad, Write, and DOS Editor text editing programs.    This 
allows you to view any text file from the WinDirs Manager window.    Just highlight a text file in the file list 
box and then choose one of the text editors.    Notepad allows you to view most small text files, Windows 
Write allows you to view any Windows Write file (having a .WRI extension) and the DOS Editor will allow 
you to view ASCII text files.    

The Select Viewer option of the Editors menu lets you select (or un-select) a graphics program with which
to view your graphics files.    For complete information about viewing graphics with WinDirs, see Graphic 
Viewer Overview.



Sys-File Info
The items in the Sys-File Info menu give you more technical information about the size of directories and 
types of files on your system.    All of the Sys Info options will give you information about whichever 
directory you presently have highlighted or about your whole system if you have your root highlighted.      
Click on the different menu options below for more information.

Sub-Topics:
Sys Info
Get File Version
Set System Time and Date
View Selected File



Sys Info
Sys Info gives you the basic information about your PC, including your memory resources and the version
of your operating systems.



Get File Version
This gives you the version of any file that you choose.



Set System Time and Date
This brings up a form which allows you to set your system's internal time and date.



View Selected File
The View File option allows you to view any file on your system in a variety of formats, including Hex and 
Decimal.    To a view a file, select it from the file list box and then choose "View File" from the menu.    You 
can also choose a file from within the View File window by using its "File" menu.    Use the other menus in 
the View File window to choose the format for viewing the file, or for viewing one cell at a time.



Dir Size
The Dir Size menu has two items:    Get Dir Size and Selected File(s) Size.    Get Dir Size gives you 
information about whichever directory or drive you have highlighted..    If the directory has subdirectories, 
it comes up with a box asking if you would like to include the subdirectories.    It then lists the directory 
information just below the file list box:    the total number of files, the total bytes, and the number of 
subdirectories.    Selected File(s) size gives you the size (in bytes) of a file or group of files.    Multiple files 
can be chosen by holding down the shift key and choosing a group of contiguous files or by holding down 
the Control key and clicking on the files.



Attrib Options
This menu option lets you control the attributes of the files on your system.    The first menu item, Show 
Attributed Files in Current Dir is an option that you can toggle either on or off.    Once you have clicked on 
it, the WinDirs Manager file list box will list only files that are attributed:    Attributed files are Read-Only, 
Hidden, System or Archive files.    Click on it again to turn off this viewing option.

The remaining items in the Attrib Options menu let you control all of your file attributes.

The first choice, "Attrib as Normal," will undo any file attributes and make the file into a "normal" 
unattributed file.    

The next option, Attrib +r turns on the "Read-Only" attribute of a file.    When a file is Read-Only it can be 
viewed but cannot be deleted or modified.

The next choice, Attrib +s, turns on the "System" attribute of a file.    The System attribute indicates that a 
file is used as part of the operating system.    System files are hidden.    They can be viewed (once you 
know they are there) but cannot be changed or deleted.

The next option, Attrib +h turns on the "Hidden" attribute of a selected file.    When a file is set as hidden, it
is not listed in any normal directory listing in Windows or DOS.    Hidden files are generally files so vital to 
a program's operation that it is considered best to not even let people know they are there.    Hidden files 
are also Read-Only.    You can view them, but you cannot change or delete them.

The next three options, +h +r, +r +s, +s +h, and +r +h +s, give you some choices for combinations of 
attributes that you might want to add to your files.

The attributed files on your PC are obviously very important to the functioning of your system.    Be very 
careful when using these attribute options.



Win Utils
The Win Utils menu gives you a few specialized tools for understanding your Windows files and 
applications.    Click on the menu items below to learn more about them.

Sub-Topics:
Win Master Task List
Windows (class names)
Sys Edit
Program Manager



Win Master Task List
The first Win Utils menu item is the Win Master Task List.    This is similar to the regular Windows Task 
Manager, except that it is more complete.    It also gives you information about the system resources that 
are being used by the applications that you are using.    If you get too many programs running at once it 
will slow down your computer.    The Task List shows you which programs are running.    If you double click
on one of the programs in the list it will come up on your screen and you can then close it if you want to 
and then see what impact this has on your system resources by pushing the "Refresh" button to update 
the resource information.



Windows (class names)
The next item under Win Apps is "Windows (class names)".    This is a tool that you can use to look 
"behind the scenes" at your Windows applications.    When you choose it, you will see a box come up on 
your screen that lists information about different Windows items on your screen as you move your cursor 
around.    The information given includes "hWnd", "Class" and "Parent."    hWnd stands for window handle.
Every window in every Windows application has its own unique "handle" which is a number which the 
computer uses to identify it.    Each window is also a member of a "Class" which gives it a set of attributes 
that define fundamental aspects of its functionality and appearance.    Some common Windows classes 
are "button", "combo box" or "listbox".    Windows are also arranged in a hierarchy, with a parent window 
having a number of "children."    When you use the Windows (class names) function, you can see the 
hWnd (handle) of the parent for each window listed next to "Parent."    If there is no parent that means that
the selected window is the parent and has no parent above it.

Under the Window Options menu of the Windows (class names) box you can also choose "Top Level 
Forms" which will list all of the windows that are presently on your screen.    You can then highlight 
windows from this list and choose an item from the Options menu to find out information about the chosen
window.    In the Options menu you can find out about the Position, Size, Win Styles and Class Info of a 
selected window.    When you are finished looking at the Top Level Forms you can click on the Activate 
Mouse Move button to return to the original form.

Once you have activated the Windows (class names) box, WinDirs becomes minimized and your 
Windows Program Manager window appears.      You can then open up other Windows applications to find
out about their window information.    When you are finished with the Windows (class names) window, 
click on the "Exit" menu item.    WinDirs will reappear when the Windows (class names) box is closed.



Sys Edit
When you choose this option you will see a series of windows containing all of your system files.    This is 
a quick way to access your autoexec.bat file or config.sys file for some quick editing.



Program Manager
This item brings up the Windows Program Manager window on top of the WinDirs window.



On Top
You can toggle this option on or off.    If you have it on, you can minimize the WinDirs window and it will 
stay on top of any Windows program that you are running so that you can have instant access to it.



Exit
The Exit menu has two choices.    Exit WinDirs closes the WinDirs program and returns you to Windows.   
The "Exit Windows and return to DOS" option gives you a quick way to close out Windows completely 
and return to DOS.    All active Windows applications will be closed and you will be prompted if there is 
any document that needs to be saved first.



Archiver jr
The Archiver jr window of the WinDirs program allows you to uncompress files using PKZIP, LHA, ARJ 
and Microsoft's Expand program. 

The compression program that you are likely to use most often is "PKZIP"    If you don't already have this 
program, you will need to get it in order for this unarchiving program to work.    You can find the PKZIP 
shareware program on any online service (such as America Online or CompuServe) or on many BBSs.    
It is a Shareware program which has a $47.00 registration fee.    PKZIP is actually a group of EXEs that 
perform different tasks.    For the Archiver jr program, you will need PKUNZIP.EXE and PKZIPFIX.EXE.    
The PKZIP program is generally considered the industry standard for compression.

The two other compression programs that you can access using the Archiver jr window are LHA (files 
have the .LZH extension), and ARJ.    These are two other extensions that you may run into out in 
cyberspace.    LHA is a free shareware compression program that you should also be able to find online.    
The compressed EXE file is LHA213.EXE (EXE name depends on version), but the actual EXE that you 
need for the Archiver jr program is LHA.EXE.

ARJ is another popular compression program.    It is a shareware program which can be registered for 
$40.00.    The compressed EXE is ARJ241.EXE and should also be available on most online services.    
The EXE that you need for the WinDirs program is ARJ.EXE.

In order for the Archiver jr program to work, all of the EXE files for these three compression programs 
must be loaded into your computer and located in a directory within your path (e.g. the DOS directory).    
Your path statement is located in your AUTOEXEC.BAT file.    (A typical path statement would be:    PATH 
= C:\DOS; C:\WINDOWS; C:\UTILS    etc.)

The Microsoft compression program Expand.exe is included with the WinDirs program and has already 
been loaded into your Windows directory.

Sub-Topics:
Archiver jr Buttons



Archiver jr Buttons
When you double-click on a compressed file, the Archiver jr window comes up to allow you to choose the 
directory that you want to uncompress the file into.    You will see three buttons at the bottom of the form.   
The captions on these buttons change, depending on which kind of compressed file you have chosen.    
The first button is the uncompress button, which is labeled Un Zip, Un Arj, Un Lzh or Expand.    After you
have chosen your destination directory, click on this button to uncompress the file.    Archiver jr will 
uncompress the file and then return you to the WinDirs window where you will see the uncompressed files
listed in the directory you have chosen.

Archiver jr runs a test on the compressed file before it uncompresses it.    If it finds a file that has been 
corrupted, you will get a message that reads "There is a problem extracting this file."    If it is a ZIP file, 
you will be asked "Would you like to run Pkzipfix to try to correct this?"    Pkzipfix can often do a pretty 
good job restoring your ZIP file.    If you choose Yes, you will see a message that says "Pkzipfix has just 
made a new file called PKFIXED.ZIP located on your Root Drive.    Now use PKunzip to extract the 
contents of this file in a directory of your choice."    When you click on OK you will see that the Source file 
list box has moved to your root directory and you will see the PKFIXED.ZIP file there.    (If Pkzipfix was not
able to recover the file, you will get a message that says "Sorry, unable to repair.")    Double-click on it to 
unzip it like you normally would, and, if Pkzipfix was successful, you will see the files uncompressed into 
your Target directory.

The Expand program is used to uncompress files that have been compressed to save space in Microsoft 
programs.    The Expand.EXE has been included with WinDirs and has been added to your Windows 
directory.    When these files are compressed the final character of the file extension is replaced with a 
"bar" _.    For instance, dosit.exe becomes dosit.ex_.    When you double-click on a compressed file and 
then click on the Expand button, you will be prompted to replace the bar '_' at the end of the file extension
with the proper letter.    For the file "dosit.ex_", you would take out the bar and replace it with an "e."

The other two buttons at the bottom of the Archiver jr window are for viewing the contents of the 
compressed file and uncompressing multi-directory or multi-disk files.

If you click on View Zip, View Lzh or View Arj, a report will come up on your screen listing information 
about the files that have been compressed.    The report will list such things as file size before 
compression, compressed size of the file, the percentage of the reduction in file size, original date of the 
file, and the names of the compressed files.    After looking at the report, close the report form to continue 
uncompressing the file.

The Un Lha-x or Un Arj-x buttons are for    extracting directories and subdirectories of a compressed file 
if a multi-level directory has been compressed.    Using the "-x" option makes sure that the files end up 
back in their subdirectories and not all in one directory.    But this option will also work just fine for 
uncompressing a file without subdirectories, so there's no harm done if you choose it by accident.

The Un Span button is for the ZIP files only.    It is used only when you have a large ZIP file that has been 
saved on multiple floppy disks.    In order to unzip such a file, you need to insert the final disk, double-click
on the zip file, and then click Un Span.    Un Span will take the ZIP file off of the disks, combine it into one 
ZIP file and put it into the target directory.    To unzip that file, you then double-click on it and unzip it in the 
normal fashion.

The Archiver jr MkDir button allows you to create a new directory to uncompress files into.    Clicking on it 
will bring up a window that prompts you to type in the name of the new directory. 



The Delete *.* button will delete all files from the directory you have chosen, so that you can have an 
empty directory to uncompress files into.



Echo On Window
The Echo On window allows you to copy, move and search for files and also gives you access to many of 
the same functions that are available in the main WinDirs program.    Under "Options", Echo On also 
provides a small disk formatting program.

Click on the buttons and menus to learn about the Echo On functions.



Mkdir Button
The Make Directory button allows you to make a subdirectory from wherever you are.    Simply click on 
whatever directory you want to make a subdirectory of (in either the Source or Target list box) and then 
click on Mkdir (the red Mkdir on the left for Source and the Black Mkdir on the right for Target).    A box will 
come up with the path already displayed.    Click at the end of the path in the text box and type in the 
name of your subdirectory.    Then click on OK or push Enter.    You will see the new subdirectory appear 
in the directory list box.

NOTE:    You can also type the name of your new subdirectory directly into the input box above the Mkdir 
button on either the Source or Target side.    Instead of bringing up the input box for you to fill in the name,
the program will simply ask you to verify your new directory and then it will create it.



RD (Remove Directory) Button
The RD button will delete whichever directory you have highlighted, as long as it has no files in it.    The 
red printed RD button on the left will remove a Source directory and the black printed RD button on the 
right will remove a Target directory.



Del Dirs Button
This button allows you to delete any directory along with everything that is inside it (files and 
subdirectories).    Highlight the directory that you want to delete in either the Source or Target file list box.   
When you click on the Del Dirs button (the one on the left for Source, the one on the right for Target), a 
window will come up asking for the name of the directory you want to delete.    You will see the path 
already entered in the text box of the window.    Click on OK and a box will come up asking you if you are 
sure you want to delete the directory and its contents.    If you click on YES, you will see Echo On deleting
the directory and all of its contents.



Rename File Button
This button allows you to change the name of any file.    Highlight the file that you want to change the 
name of in either the Source or Target file list box and then click on the Rename File button (the red 
printed Source button on the left or the black printed Target button on the left).    A box will come up with 
the name of the file highlighted.    Simply type in the new file name (with extension) and click on OK.    You 
will see the name of the file change immediately in the file list box.

NOTE:    You can also type the new file name directly into the input box above the Mkdir button on either 
the Source or Target side.    Instead of bringing up the input box for you to fill in the name, the program will
simply ask you to verify the new filename and then it will change it.



Delete File Button
This button allows you to delete any file.    Highlight the file that you want to delete in either the Source or 
Target file list box and then click on the Delete File button (the red printed button on the left for Source 
files or the black printed button on the right for Target files).    A box will come up, listing the file.    To delete
it, simply click on OK.    The program will then give you another chance and ask you if you are sure you 
want to delete this file.    Click on Yes or push Enter and the file will be deleted.    You will see that it 
immediately disappears from the file list box.    Note that if you do not choose a file to delete, the program 
will assume that you want to delete all files (*.*) in the selected directory.    You can also delete a group of 
files by holding down the mouse button and selecting a group of files, OR by holding down the Control 
key and clicking on the files that you want to delete.    You may also use wild card characters (e.g. *.TXT) 
in the input box above the Mkdir button on either the Source or Target side.



Dir Size
The Dir Size button gives you the number of files and the number of bytes in the directory that you have 
open in either the Source or Target file list box.    Choose the red printed button on the left for the Source 
directory or the black printed button on the right for the Target directory.    The information is displayed in 
the lower right hand corner of the Source side or the Target side.



Copy Button
When you click on this button, the program copies whatever you have chosen in the Source file list box 
into whatever you have chosen in the Target file list box.    If you have a file highlighted in Source and a 
directory highlighted in Target, the program will copy the Source file into the Target directory.    If you have 
not chosen a file in the Source file list box, the program will assume that you want to copy all files from the
Source directory (*.*) into the Target directory.    You can also copy a group of files by holding down the 
mouse button and selecting a group of files in the Source box, OR by holding down the Control key and 
clicking on the files that you want to copy.    After copying, the program displays the number of files and 
number of bytes copied in the lower right hand corner of the Target area.



Move Button
The Move button works just the same as the Copy button except that it does not leave the files behind in 
the Source Directory.    Choose a file in the Source file list box and a directory in the Target list box and 
then push the Move button.    The file will immediately be moved to the Target directory.    If you have no 
file chosen, the program will assume that you want to copy all files from the Source directory and it will 
immediately do that.    You can also move a group of files by holding down the mouse button and selecting
a group of files in the Source box, OR by holding down the Control key and clicking on the files that you 
want to move.    After moving, the program displays the number of files and number of bytes moved in the 
lower right hand corner of the Target area.



Copy Dirs Button
The Copy Dirs Button is the equivalent of the DOS Xcopy function.    It is for use when you have a 
directory with subdirectories that you want to copy all at once.    Choose the directory in the Source file list
box and then choose its destination in the Target list box.    When you click on the Copy Dirs button, Echo 
On will make a complete copy    of the directory and all subdirectories in the Target location and will copy 
all of the Source files into the proper directories.    The program displays the number of files and number 
of bytes moved in the lower right hand corner of the Target area.



Exit
Choosing the Exit menu item will exit from Echo On and return you to WinDirs.



Reset
Resets all controls to default values.    Returns the directory list boxes to the root directory.



Options
The Options menu gives you access to other important Echo On functions.    The first option, Format Disk,
allows you to format a floppy disk.    For complete information about this, go to Format Disk.    The next 
two options are for the Search function, which can be used to search for a file on your system.    See 
Search Function for more information about Search.    The next two options, Notepad and Write, can be 
used for loading and viewing text files.    Go to Notepad and Write for more information.



Multi Targets
This menu item allows you to choose more than one target directory for the files that you are copying.    To
use this function, choose your first target directory and then go to the Multi Targets menu and choose 
Target Dir 1; choose your second target directory and then go to the Multi Targets menu and choose 
Target Dir 2; and choose your third target directory and then click on Target Dir 3.    After choosing your 
targets, click on the Copy button and you will see the file(s)    being copied to all three target directories.    
Clicking on the "More" item in the Multi Targets directory will give you three more targets to select.    
"Show Current Selections" will show you which target directories you have chosen.    



Help
The Help menu gives you access to the WinDirs help file.



Input Box
This is a multipurpose user input box.    When deleting files, you can use this input box to add wildcards 
for deleting multiple files, e.g. *.doc.    When renaming a file, use this box to type in the new name of your 
file.    When creating a new directory, use this box to type the name of your new directory.



Source File List Box
This is where you choose the file or directory that you want to copy or move.    The buttons with red 
printing perform operations on the files in this file list box.



Target File List Box
This is where you choose the destination of the file or directory that you want to copy or move.    The 
buttons with black printing perform operations on the files in this file list box.



Option Menu Items
Format Disk
Search Function
Notepad and Write



Format Disk
Format Disk formats a floppy disk in your disk drive.    The program will prompt you for some information 
about what sort of formatting you want to do, what disk drive you are using, and what size the disk is.    

Click on the options below to learn about the different possibilities for formatting a disk.



Format (default)
This is the regular DOS format command.    Use it for general-purpose disk formatting.



Unconditional /u
This is the lowest level of disk formatting.    With the regular format command you can actually do an "un-
format" and sometimes restore some of your data, but the unconditional format completely wipes out any 
data you may have had on the disk.    



System Files /s
This format command copies the system files onto the disk as part of the format operation.    The three 
system files (IO.SYS, MSDOS.SYS and COMMAND.COM) make the disk bootable.    This means that 
your computer could boot up and load DOS by using this disk if something was wrong with your hard 
drive.



Bad clusters? /c
This is the format command to use if you believe that your disk has bad clusters.    The /c switch will retest
all of the clusters to see whether they are bad, and if they are Format will mark them as bad so that they 
will not be used.    More information about these format switches can be found in DOS help.



Drives
You must choose a drive for the format command to work.    Choose the drive where the disk you want to 
format is.



Disk Type
You must also choose a disk type, so that the computer knows what sort of disk to format.    Most 
computers now use the 1.44M 3.5" disks.



Exit
Clicking on Exit closes the Format window and returns you to WinDirs.



Help
The Help menu gives you access to specific help on the Format window and to the WinDirs help file.



Default
Clicking on Default will set the Format options to Format (default), a: drive, 1.44 M 3.5" disks.



OK Button
This is the button that you click on when you are satisfied with your format choices and you are ready to 
go ahead and format your disk.



Search Function
The "New Search" item in the Options Menu will search for a file or group of files on your system or any 
portion of your system.    To use the Search function, you first need to choose your search pattern and 
search location in the Source file list box.    If you want to search your entire system, make sure your root 
is highlighted first (i.e. C:\), or if you want to search one directory choose that directory.    If you are 
searching for a particular file, for instance "mydoc.doc", you would type that file name into the small box 
above the Source Mkdir button, next to the drive list box.    Then just choose New Search from the 
Options Menu and you will see a list box appear on the left side of the window showing you the results of 
your search.    After the search has been performed and you have some results, you can double click on a
file in the search list box and the Source file list box will reappear and reset itself to the location of the file 
you have chosen.    You can also use wildcards to perform your searches, such as searching for *.ico (all 
icon files) or *.bmp (all bitmap files) on your system or in any directory.

The View Old Search menu option will bring up the results of the last search that you did, in case you 
need to refer to them again.



Notepad and Write
Notepad and Write allow you to view text files from the Echo On window.    Just highlight a text file in the 
Source file list box and then choose one of the text editors.    Notepad allows you to view most small text 
files and Windows Write allows you to view any Windows Write file (having a .WRI extension) as well as 
many other text files.      If you do not choose a file, Echo On will still load Notepad or Write and you can 
then create a text file.



Graphic Viewer Overview
The WinDirs window has its own graphics viewers which will allow you to view bitmaps (BMP files) and 
GIFs.    In order to view bitmap files, all you need to do is    double click on the bitmap file that you would 
like to look at.    You will see the picture come up in the upper right part of your screen.    You can 
maximize the viewer screen by clicking the upward arrow in the upper right-hand corner of the viewer 
window.    To close the viewer, just click on Close.    Use the same method to view GIF files.    Choose the 
GIF file that you want to see and then double click on it.    You will notice that the GIF viewer has an 
"Options" menu.    This gives you two options for how the GIF appears on your screen:    "Stretch" and 
"Keep Aspect".    If the Stretch option is chosen, the GIF will be stretched to fit your screen.    If the Keep 
Aspect option is chosen, the GIF file will keep its proper width to height ratio on your screen.

There are many kinds of graphic files out in cyberspace, and you will probably end up with some files 
other than BMP or GIF files.    You cannot use the WinDirs viewer to view other sorts of graphic files, but 
you can run your own graphics viewer from WinDirs.    If you click on a graphics file with a different 
extension, such as JPG, or RLE, WinDirs brings up a form which allows you to choose the EXE of your 
own graphics viewer.    You can also set your own graphics viewer as the "default" viewer and any graphic
file that you double-click on after that will come up using your viewer rather than the WinDirs viewer.    If 
you want to change to a different viewer or un-select your default viewer, go to the WinDirs "Editors" 
menu and choose "Select Viewer."    This will bring up the same viewer selection window so that you can 
change your viewer selection.



Icon Editor Overview
Icon files have the ICO extension, and there are many libraries of them online to spruce up your Windows
environment.    The ICO files often do not have very descriptive file names, however, so you may want to 
view your icons and label them for future reference.    You will notice that when you click on an icon file in 
the WinDirs file list box, the icon appears in the square box at the bottom of the window.    You can quickly 
view your icons this way, or you can use WinDirs's Icon Editor..    To access the Icon Editor, you just need 
to choose an ICO file and double-click on it.    The Icon Editor window will appear at the top of your 
screen.    The main window of the editor shows you an expanded view of the icon, which you can edit 
pixel by pixel by clicking on a color in the Color Palette and then clicking on the pixel you want to edit.



Icon Editor Window

This is the window that appears when you double-click on an icon file.    Click on the different areas of the 
window for an explanation of the various functions.

Sub-Topics:
Icon Editor - Zooming In and Out
Testing an Icon



Icon Boxes
On the right hand of your screen you will see six white boxes.    You can have six icons at a time loaded 
into these boxes and switch between them.    You will see that whatever icon you have loaded is in the 
first box.    To load another one, click on an empty box and then go down to the CATapult window and 
double-click on another icon file.    You can then switch back and forth between the icons by clicking on 
the different boxes.



Mouse Position display
Below the icon boxes you will see and "X=        Y=."    This shows the x,y coordinates of your mouse as it 
moves in the icon editing window.



Undo Icon display
The "Undo to:" icon box keeps a picture of the active icon as it appears before being changed.    If you go 
to the Edit menu and choose Undo, the icon will be returned to its original state.



Mouse Button controls
The colored squares at the bottom of the Status Area show what colors are attached to your mouse 
buttons.    The color under "Left" is the color that will appear if you click on a pixel with your left mouse 
button, and the color under "Right" will show up if you use your right mouse button.    To choose a color, 
click on the color palette with either mouse button.    You will see the color show up in the Left or Right 
mouse box. 

The bottom two boxes display the background color of the active icon and the inverse of that color.    If you
select the icon in the Edit menu (Select All) and then choose Invert, you will see all of the colors change to
their inverse.



Color Palette
The Color Palette contains solid and dithered colors you can use when editing an icon.    To select a color 
from the palette, click a color cell with the left or right mouse button.    Icon Editor assigns the selected 
color to the mouse button used to click the color cell.    You use this procedure to assign foreground colors
as well as screen and inverse colors.

Double-clicking a mouse button assigns the selected color to that button then opens the Custom Color 
Palette Window.    You can define your own colors in this window.



File
The File menu has three options.    "New" opens a blank icon file, so that you can create your own icon 
from scratch or copy an icon from the clipboard.    "Save" opens the file list box so that you can save your 
edited icon.    And "Exit" closes the Icon Editor window.



Edit
The edit menu has nine edit options.    "Undo" will undo all changes and return the icon to its original 
state.    "Cut" will remove the selected icon and put it on the clipboard.    (You have to use Select All first, to
select the icon.)    "Copy" will put a copy of the selected icon onto the clipboard.    "Paste" will paste 
whatever is on the clipboard into the present icon file.    "Select All" selects the icon that is presently in the 
edit window.    "Rotate 90 Right" rotates the icon image 90 degrees to the right, and "Rotate 90 Left" 
rotates it 90 degrees to the left.    "Invert" changes all of the colors in the active icon to their inverse.



View
The View menu allows you to choose which parts of the Icon Editor window will appear on your screen.    
You can choose to display or not to display the different areas by using the check boxes.    If you active 
the Grid you will see a grid made up of lines or dots show up on the icon in the edit window.



Icons
This menu lists the icons that have been loaded into the six icon boxes.    You can use this menu to switch
between the different icons.



Color
There are a couple of different color palettes to choose from.    This menu allows you to toggle between 
the different options.



Brush
This menu allows you change brush sizes for editing icons.    If you choose the Small 1x 1 brush you will 
just color one pixel at a time on the icon, but if you increase the size then you will color a larger area.



Help
This menu allows you to view this help file.



Icon Editor - Zooming In and Out
The vertical scroll bar along the left side of the editing area increases or decreases the magnification of 
the currently selected icon.

You can use this scroll bar to display the icon at actual size or magnify it to fill the editing area.    When 
you resize the Editor, the scroll bars adjusts to the new window size so that the icon stays at the same 
magnification.



Testing an Icon
You can test the icons you create to see what they look like when dragged.    This ability is especially 
helpful when your icon contains transparent regions.

To test an icon, drag the icon from its icon box in the Status Area.    You can test only the currently 
selected icon.    You cannot drop icons dragged from the Status Area.




